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Trademarks 
 

Bynari Insight products are trademarks of Bynari, Inc. 
 
Microsoft Windows, Windows Mobile, Outlook, Windows XP, Windows Server 2003, Windows 
Vista are all registered trademarks of Microsoft Corporation in the United States, other countries, 
or both. 
 
BlackBerry is a registered trademark of Research In Motion Limited in the United States, other 
countries, or both. 

All other trademarks are the property of their respective owners. 
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Technical Support 
 

When you purchase any of Bynari’s products, the products include one year of free support and 
maintenance.  To purchase additional yearly support and maintenance, please contact 
sales@bynari.net.    
 
Customers who are current on support receive one year of product maintenance, upgrades and 
unlimited email and telephone matching the purchased support package. 

Support is available to customers worldwide. 

To contact technical support:  

U.S. Toll Free Telephone:  1-800-241-1086 
International Telephone:  001-214-350-5772 
 
To open a new support ticket:  http://www.bynari.net/support/  

For FAQs:  http://www.bynari.net/users/kb.php 



Insight Connector 4.0 Installation and Configuration Gude 

4 
Bynari Inc.  222 W. Las Colinas Blvd, Suite 1320N, Irving, Tx  75039 

001-214-350-5772 
001-214-352-3530 fax 

sales@bynari.net 
www.bynari.net 

Licensing 
The Bynari Insight Connector utilizes a licensing key system that assigns and stores the number of 
licenses that have been purchased by the customer. When Outlook starts, Insight Connector (IC) will 
either contact the patched version of Insight Server 4.3, which allows auto-registration with IC 4.0, or 
Insight Server 4.4. If you are using a 3rd party server, it will contact the Bynari license key server over 
the Internet to validate and activate the installed license. Activation will be attempted each time 
Outlook is started or until activation of the license is successful.  
 

Note:  The license key server URL is http://register.bynari.net. 

If you encounter any issues while activating your Insight Connector license, please see below for a 
possible solution:  

·  The client systems may be blocked from accessing the Internet, or Internet access is 
temporarily unavailable. 

·  The license key entered during the installation of the Insight Connector may be invalid.  This 
could include issues such as an incorrect key or incorrect key version. 

·  The number of client licenses has been exceeded. The Bynari Key Server tracks how many 
systems have been activated using a given license. If the number of activated clients 
exceeds the total for the license, the Insight Connector will inform you that additional licenses 
need to be purchased. 

·  If you need to reinstall the Insight Connector software on a new system due to either 
hardware failure or system upgrade and need to unregister, do the following (See section 4.3 
for complete details):  

o Open Outlook 
o Click on “About” tab in the Insight Connector toolbar 
o Click on “License” 
o Click on “Unregister” 

If you experience problems with license activation,  please contact your reseller or Bynari 
support at http://www.bynari.net/support/ .  

Important Notes:    
·  This documentation applies to the latest 4.0 build of the Insight Connector available from 

Bynari. 
·  Make sure that Outlook is setup as the default e-mail client. To verify this on the workstation, 

go to Control Panel > Internet Options > Programs and make sure that Outlook is selected in 
the drop down box next to E-mail. 

·  Insight Connector 4.0 has been tested with Insight Server, Cyrus, Courier, and Kolab IMAPv4 
servers. Insight Connector supports all base specifications as described in RFC 3501: 
Internet Message Access Protocol version 4rev1. If your IMAPv4 server supports the 
specifications in RFC 3501, Insight Connector 4.0 may be compatible with your server. If you 
encounter issues with a different type of unsupported server, contact us by going to 
http://www.bynari.net/support/ and creating a support ticket.  The Bynari support team will 
provide a reasonable effort in working with you. 

 
 
 



Insight Connector 4.0 Installation and Configuration Gude 

5 
Bynari Inc.  222 W. Las Colinas Blvd, Suite 1320N, Irving, Tx  75039 

001-214-350-5772 
001-214-352-3530 fax 

sales@bynari.net 
www.bynari.net 

 

Table of Contents 
Trademarks ........................................ ...................................................................................... 2 

Technical Support ................................. ................................................................................... 3 

Licensing ......................................... ......................................................................................... 4 

1 Insight Connector version 4.0 ..................... ..................................................................... 6 

1.1 Architecture ________________________________________________________________ 6 

1.2 Features of Insight Connector __________________________________________________ 6 

1.3 Supported Platforms _________________________________________________________ 7 

1.4 Supported IMAP Servers ______________________________________________________ 8 

1.5 Supported mobility devices and software _________________________________________ 8 

1.6 Known Limitations ___________________________________________________________ 8 

2 Installation ...................................... ................................................................................... 9 

2.1 Preparing Your System (Pre-Installation) ________________________________________ 9 

2.2 Installing Insight Connector – New Installation __________________________________ 12 

2.3 Installing Insight Connector – Upgrade _________________________________________ 20 

2.4 Installation Logs ____________________________________________________________ 24 

3 Post Installation Configuration ................... .....................................................................25 

3.1 Import “Rules and Alerts” ___________________________________________________ 25 

3.2 Insight Connector Toolbar ___________________________________________________ 27 
3.2.1 Folder ................................................................................................................................................... 27 
3.2.2 Refresh Folders .................................................................................................................................... 33 
3.2.3 Account ................................................................................................................................................ 33 
3.2.4 More Settings ....................................................................................................................................... 34 
3.2.5 Quota ................................................................................................................................................... 50 
3.2.6 About ................................................................................................................................................... 51 

4 Using Insight Connector ........................... .......................................................................51 

4.1 Viewing Shared Folders ______________________________________________________ 51 

4.2 Free/Busy Configuration _____________________________________________________ 52 

4.3 Show / Hide Toolbar _________________________________________________________ 56 

4.4 Purge Messages _____________________________________________________________ 56 

5 Registering and Unregistering Insight Connector ... ......................................................57 

5.1 Auto Registration ___________________________________________________________ 57 



Insight Connector 4.0 Installation and Configuration Gude 

6 
Bynari Inc.  222 W. Las Colinas Blvd, Suite 1320N, Irving, Tx  75039 

001-214-350-5772 
001-214-352-3530 fax 

sales@bynari.net 
www.bynari.net 

5.2 Register the Insight Connector ________________________________________________ 58 

5.3 Registration Complete _______________________________________________________ 61 

5.4 Unregister Insight Connector _________________________________________________ 62 

6 Reporting Problems ................................ .........................................................................63 

 

1 Insight Connector version 4.0 
The Bynari Insight Connector acts as a MAPI transport for Microsoft Outlook.  As a MAPI 
transport provider, the Connector interprets all the different types of folders used by Outlook. 

When Insight Connector is used in conjunction with the Bynari Insight 
Server, a powerful collaboration environment is created.  Users are 
able to share mail folders, contacts, tasks, and calendars with other 
individuals.  Public folders of each type can also be created and 
maintained by system administrators through the web admin interface.  
All of these functions are supported through the familiar Outlook 
interface eliminating any need for costly end user training. 

1.1 Architecture 

Messaging Application Programming Interface or MAPI has two major 
components.  Applications such as Microsoft Outlook use the client 
side interface to contact the MAPI subsystem for all communications 
with the message store.  There is also a service interface which is used by programs such as 
Insight Connector to provide the MAPI transport services for accessing the message store on the 
server. 

Insight Connector acts as the transport that provides messaging services directly to the MAPI 
subsystem and stores this information on Insight Server via the IMAP protocol. 

                                                                                                                                         
 
Figure 1 - MAPI Architecture 

1.2 Features of Insight Connector 
Insight Connector 4.0 offers the following features: 

·  Native MAPI implementation 

·  Mobile sync with Windows Mobile device 

·  Mobile sync with Blackberry Mobile device 

·  Mobile sync of contacts with iPhone 

·  Support for new Microsoft PST architecture enables files larger than 2G 

·  Simple click-and-go installation and configuration 
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·  Auto registration using Insight Server 

·  SSL secure connection support 

·  Mail, Calendar, Contacts, Journal, Notes and Task folder support 

·  Native Outlook calendar functions  

·  Free/Busy support  

·  Shared folders including Calendars, Contacts, Tasks, Journals, Notes and Mail 

·  Contact Distribution Lists 

·  Outlook Rules Wizard  

·  Read receipts 

·  IMAP folder subscriptions 

·  Shared  access controls  

·  Header only download  

·  Offline support 

·  Grouping 

·  Multiple user accounts 

·  Voting Buttons 

·  Native iCalendar and vCard format support 

·  IMAP IDLE support 

·  Sieve rules support for Out of Office automated replies 

·  Mailbox quotas 

·  Ability to re-download messages 

·  And more … 

1.3 Supported Platforms 
Insight Connector 4.0 is compatible with the following software.  If you are using a version that is 
not listed, or software that is not supported, upgrade to a supported version. 

Supported Windows ® Versions 

Windows® XP 

Windows® 2003 

Windows® Vista 

Windows® 7 

 

Supported Outlook ® Versions 

Outlook® 2003 

Outlook® 2007 

Note:   Installing the Connector in a Windows Terminal Server 
environment is not supported. However, multiple customers are using 
the Connector in this environment. Please ensure that the users have 
permission to access the location of their local cache. 

Supported Languages 

·  English 
·  French 
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·  German 
·  Italian 
·  Spanish (Spain) 
·  Portuguese (Brazil) 
·  Dutch  
·  Norwegian 
·  Russian 
·  Swedish 
·  Taiwanese/Chinese    
·  Czech 
·  Hebrew 

 
Note:  Other languages are provided and may be used but are not formally 
supported. Problems with translation, spelling, grammar and proper 
character encoding may be encountered. 

1.4 Supported IMAP Servers 
·  Cyrus 
·  Courier 
·  Kolab 
·  Citadel 

1.5 Supported mobility devices and software 
Insight Connector 4.0 includes mobility support for several devices including Blackberry, iPhone 
and Windows Mobile. The following versions are compatible with Insight Connector 4.0. 

 

Device and OS version Windows OS Version Desktop sy nchronization 
software 

Blackberry  4.5.0 Server 2003, XP & Vista Blackberry desktop manager 
5.0.0.11 

Blackberry desktop manager 
5.0.0.B28 

iPhone 2.2.1 or 3.0.1 Server 2003,XP & Vista iTunes 8 

Windows Mobile 6 Pro 

Windows Embedded CE 6.0 

Server 2003, XP Active Sync 4.5 Build 5096 

Windows Vista Device Center 6.1 

1.6 Known Limitations 
·  Microsoft Business Contact Manager is not compatible with Insight Connector. 
·  Smart Phone synchronization is dependent on the hardware and the software provider.  
·  Slashes in folder names are not allowed. 
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2 Installation 
2.1 Preparing Your System (Pre-Installation) 

Before you begin: 

The Connector 4.0 software must be installed by the Windows login user. Additionally, this user 
needs “administrator” rights to install the software. The users’ rights can be changed to install the 
Connector and then reset to the original rights. 

Before you begin the installation procedure, perform the following steps: 

Step 1: Install Microsoft ® Windows and/or Microsoft ® Outlook 

Supported Windows ® Versions 

Windows® XP 

Windows® 2003 

Windows® Vista 

Windows® 7 

 

Supported Outlook ® Versions 

Outlook® 2003 SP3+ 

Outlook® 2007 SP2+ 

Note: If you are using versions that are not listed, upgrade 
to a supported version. 

Step 2: Install the Latest Updates for Microsoft ® Windows and Outlook 

Go to the Microsoft® website or check with your IT Administrator to verify that you have 
installed the most current critical updates and service packs for both your Windows 
operating system and Outlook. 

http://update.microsoft.com  – Microsoft® updates. 

Outlook 2003 minimum required version to install 

·  Click on “Help” > “About Microsoft Office Outlook” 

 
Figure 2  – Outlook 2003 about dialog 
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Outlook 2007 minimum required version to install 

·  Click on “Help” > “About Microsoft Office Outlook” 

 
Figure 3  – Outlook 2007 about dialog 

Step 3: Backup “Rules and Alerts”. 

Outlook “Rules and Alerts” functions are used to organize incoming email. These functions al-
low users to set custom “actions” that will be performed automatically on incoming messages.   

 
Important Information:  "Rules and Alerts" will not transfer du r-
ing new installation of Insight Connector 4.x or wh en upgrading 
from Insight Connector 3.x to 4.x. "Rules and Alert s" are stored 
locally on your computer. They are not uploaded to the server. 

 
Export “Rules and Alerts” 

1. Open Outlook 

 

2. Click on “Tools” > “Rules and Alerts…” 
 

 
Figure 4  –Installation – Tools – Rules and Alerts 
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3. Under the "E-mail Rules" tab, click on "Options". 
 

 
Figure 5  –Installation – Tools – Rules and Alerts 

 
4. Under the "Import and export" area, click on the "Export Rules..." button. 

 

 
Figure 6  –Installation – Tools – Rules and Alerts – Options 

 
 
5. Type a new name for the rules or keep the default. 
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Figure 7  –Installation – Tools – Rules and Alerts – Save Exported Rules as 

 
6. Click “Save”. 
 
7. Click “OK” to remove all dialog windows. 
 
8. Close Outlook to continue installing or updating Insight Connector 4.0. 

2.2 Installing Insight Connector – New Installation  
The 4.0 Insight Connector installation wizard standardizes the installation process for 
Outlook.   

The following section explains how to install the Insight Connector 4.0 for the first time on a 
computer.  The “upgrade” process is slightly different and available in the section 2.4 of this 
manual. 

 
Note: The Bynari Insight Connector will only install on systems where the 
user has “administrative” rights. The users’ rights can be changed to install 
the Bynari Insight Connector and then reset to the original rights after the 
installation has completed. 

 
Important Information : In some cases, virus scanning add-ins for Outlook 
may need to be disabled for the installation of the Insight Connector. 
Disabling the virus scanning Outlook add-in should not change the 
functionality of your antivirus software. 

 

Before you begin : 

 
1. Verify that all steps in “Preparing Your System” (Pre-installation) section 2.1 are complete. 
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2. Unzip the Insight Connector 4.0 compressed file by right-clicking and selecting “Extract All”. 

 

 
Figure 8  – Installation – Downloaded zipped Insight Connector 

 
3. Double Click on the installer. 

 

 
 Figure 9  – Installation – Insight Connector Installer Package 
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4. Welcome Dialog:  

Double click the installation setup file to start installation. The setup wizard will display the 
“Welcome Dialog” window.  Select “Next” to continue with the installation process. 
 

 
Figure 10 – Installation – Insight Connector welcome dialog – Setup Wizard 

 
 
 
5. End User License Agreement:  

Read the license agreement.  If you agree, select the button, “I accept the license agreement” 
and select “Next”. 
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6. Create New Outlook Profile: 
The Insight Connector will automatically create a profile for Outlook.  The default name for 
this profile is “Bynari Insight Connector”.  The “default name” is a user defined field and may 
be changed if needed.  Place a check in the box labeled, “Prompt for which profile to use 
when starting Outlook (Recommended)”, if you have multiple profiles in Outlook.  Selecting 
this will prompt for profile selection when Outlook starts. Click “Next” to continue installation. 
 

 
Figure 11 – Installation – Insight Connector Create New Profile 
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7. Account Information: 

This screen provides the Insight Connector with the information needed to create the Outlook 
profile for your email account during the installation process.  
The following basic information is needed to complete this screen: 

 
a. Your Name 
b. E-mail Address 
c. IMAP Server Address 
d. SMTP Server Address 
e. Username 
f. Password 

 

 
Figure 12 – Insight Connector – Account Information 

  
   

·  Fill in requested information. 
 

·  Click “Next” to continue. 
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8. Select Destination Location:  
The default installation destination for the Insight Connector is:  
C:\Program Files\Bynari, Inc\InsightConnector.  

A custom installation location may be used.  Select the “Browse” button to choose an 
alternate location to install the Insight Connector. Click “Next” to continue the installation. 
 

 
Figure 13 – Insight Connector – Select Destination Location 

 
 
 

9. Insight Connector Toolbar Options: 
By default, the Insight Connector Toolbar is configured to be displayed.  Displaying the 
toolbar is the recommended configuration. Select “Yes” to hide the Insight Connector toolbar.  
Click “Next” to continue. 
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Figure 14 – Insight Connector – Display Toolbar 

 

10. Insight Connector Server Choice:  
By default, the Insight Connector will select “Bynari’s Insight Server”. If you are not using 
Insight Server 4.4, select “Other 3rd party server”. 

 

 
Figure 15 – Insight Connector – Display Toolbar 

 
11. Ready to Install:  

Review configuration settings and select “Install” to install the Insight Connector. Click “Next” 
to continue the installation. 
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Figure 16 – Insight Connector – Ready to Install 
 

12. Setup Complete : 
To automatically start Outlook, place a check in the box labeled “Run Outlook” and select 
“Finish”. 
 

 
Figure 17 – Insight Connector – Finish Install Wizard 
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2.3 Installing Insight Connector – Upgrade 

Upgrading the Insight Connector is similar to the steps discussed under “Installing Insight 
Connector – New Installation” in section 2.1. 

In the upgrade process, no profile will be created and all of the original user data from the 
previous installation of the Insight Connector is used. The Insight Connector will 
automatically upgrade profiles from earlier Insight Connector versions.  Insight Connector 
3.x used a “local cache” data storage system while the Insight Connector 4 uses a 
Microsoft PST file to store data.  

When upgrading from any of the Insight Connector 3.x versions, your profile will be 
upgraded to the new PST architecture.  The Insight Connector will need to perform an 
initial synchronization after the upgrade process completes. 

Important Information:  During the initial synchronization process, the 
Connector will download the newest emails first, and then it will continue to 
synchronize in the background. This allows the end-user to begin using 
Outlook immediately while synchronization continues. 

 

Before you begin : 

1. Verify that all steps in “Preparing Your System” (Pre-installation) section 2.1 are 
complete. 

  

2. Unzip the Insight Connector 4.0 compressed file by right-clicking and selecting “Extract 
All”. 
            

 
Figure 18 –Installation – Downloaded zipped Insight Connector 
 
3. Double Click on the installer to start the installation process. 

 

Note: The Connector installer will automatically determine if your profile 
needs to be upgraded.   
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 Figure 19  – Installation – Insight Connector – Installer Package 
 
4.  Welcome Dialog: 

Double click the installation setup file. The setup wizard will display the “Welcome Dialog” 
window.  Select “Next” to continue with the installation. 

 

 
Figure 20 – Installation - Insight Connector welcome dialog – Setup Wizard 

 
5. End User License Agreement: 

Accept the terms of the End User License Agreement to install the Insight Connector.  If 
you agree to the terms of the license, select “I accept the agreement” then select “Next” 
to proceed to the next step. 



Insight Connector 4.0 Installation and Configuration Gude 

22 
Bynari Inc.  222 W. Las Colinas Blvd, Suite 1320N, Irving, Tx  75039 

001-214-350-5772 
001-214-352-3530 fax 

sales@bynari.net 
www.bynari.net 

6. Profile Upgrade 
If Insight Connector finds any existing profiles, it will upgrade them to the latest version. 
Confirm that you would like to continue by selecting “Yes”. 

 
Figure 21 – Insight Connector – Prompt to upgrade profiles 

 

7. Select Destination Location:  
The default installation destination for the Insight Connector is:  
C:\Program Files\Bynari, Inc\InsightConnector.   

A custom installation location may be used.  Select the “Browse” button to choose an al-
ternate location to install the Insight Connector.  Select “Next” to continue the installation.  
If the existing installation location is used, the following informational window will be dis-
played.  Select “Yes” to proceed to the next step.  

 
Figure 22 – Insight Connector – Upgrade Destination Location 

 

8. Insight Connector Toolbar Options: 
By default, the Insight Connector Toolbar is configured to be displayed.  Displaying the 
toolbar is the recommended configuration. Select “Yes” to hide the Insight Connector 
toolbar.  Click “Next” to continue. 
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Figure 23 – Insight Connector – Display Toolbar 

 
9. Ready to Install:  

Review configuration settings and select “Install” to install the Insight Connector. Click 
“Next” to continue the installation. 

 

 
Figure 24 – Insight Connector – Ready to Install 

 
10. Setup Complete:  

To automatically start Outlook, place a check in the box labeled “Run Outlook” and select 
“Finish”. 



Insight Connector 4.0 Installation and Configuration Gude 

24 
Bynari Inc.  222 W. Las Colinas Blvd, Suite 1320N, Irving, Tx  75039 

001-214-350-5772 
001-214-352-3530 fax 

sales@bynari.net 
www.bynari.net 

 

 
Figure 25 – Insight Connector – Upgrade Complete 

2.4 Installation Logs 

Error Logging  

This feature is only activated during a new installation of the Insight Connector when a new 
profile is created.  Error logging is not enabled during the upgrade process. 

Viewing the Log File  

 The Insight Connector generates a log file named “Bynari.log ” in the user’s %TEMP% 
directory during the installation process. 

Viewing the Log File: 
1. Select “Start ” > “Run”. 
2. Type %TEMP% on the Run input field and select “OK”. 
3. A new explorer window will open displaying the contents of the user’s %TEMP% 

directory. 
4. Browse this directory for a text file named “Bynari.log ”.  This file can be viewed with any 

text editor. 
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3 Post Installation Configuration 
3.1 Import “Rules and Alerts” 

 
Important Information:  "Rules and Alerts" will not transfer during 
new installation of Insight Connector 4.x or when upgrading from 
Insight Connector 3.x to 4.x. "Rules and Alerts" are stored locally 
on your computer. They are not uploaded to the server. 

1. Open Outlook 

2. Click on “Tools” > “Rules and Alerts…” 

 

 
Figure 26  –Installation – Tools – Rules and Alerts 

3. Under the "E-mail Rules" tab, click on "Options". 
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Figure 27  –Installation – Tools – Rules and Alerts 

4. Under the "Import and export" area, click on the "Export Rules..." button. 

 
Figure 28  –Installation – Tools – Rules and Alerts – Options 
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5. Type a new name for the rules or keep the default. 
 

 
Figure 29  –Installation – Tools – Rules and Alerts – Import Rules from 

 
6. Click “Open”. 
 
7. Click “OK” to remove all dialog windows. 
 

3.2 Insight Connector Toolbar 
 

All custom configuration settings can be made through the Insight Connector 
Toolbar. 

 
The Insight Connector toolbar consists of five buttons: 

�  Folder  – Used for setting folder Access Control List (ACL) permissions and 
folder types. 

�  Refresh Folders  – Used to refresh the Outlook folder tree from the IMAP 
server. 

�  Account  – Used to modify account configuration settings. 
�  Quota – Used to display the user’s current quota status. 
�  About  – Displays version number and licensing information. 

 

 
Figure 30 – Insight Connector Toolbar 

 
 

3.2.1 Folder 
Selecting the “Folder” button on the Insight Connector Toolbar will open the “Folder 
Permissions” dialog window. 
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Figure 31  – Insight Connector – Folder 

 
Figure 32 – Insight Connector – Inbox Folder Permissions 

This feature is used to share folders with other users on the same system.  It is also used to 
manage the permissions granted to other users using ACL. Folder types can also be 
changed. 

Sharing Folders 

Sharing folders using Insight Connector 4.0. 

 
Figure 33 – Insight Connector – Folder sharing 
 

Add New User  

Selecting the “Folder” button opens the “Folder Permissions” dialog window.  From the 
“Folder Permissions” dialog window, additional users can be added by selecting the “Add” 
button 
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Figure 34 – Insight Connector – Add New User 

·  Set Specific Permissions 
Enter the appropriate username or full email address. 
 

Note: Some servers require the entire email address to be used 
when adding a new user to a folder share while others only require 
the username. Check with your systems administrator for specific 
information about your server requirements. 

 
·  Select “OK” to confirm adding the new user’s ACL to the specified folder. 

 
Figure 35 – Insight Connector – Add New User 

·  Search Corporate Directory  
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This feature is used to search an LDAP directory to find users. Enter a value 
to search and then click “search”.  
 
In the “Search Results”  field, select a user or multiple users by holding the 
control key and clicking on the listings to add and then click “OK”. 
 

·  “Search by” option 
The pull-down list contains five ACL search settings: 
Any  – Search all fields. 
First Name  – Search by “First Name”. 
Last Name  – Search by “Last Name” 
Display Name – Search by “Display Name”. 
E-mail Address  – Search by “E-mail Address”. 

 
·  Configuration 

This button provides quick access to the LDAP configuration settings. See 
LDAP settings under section 2.5.4.2. 

 
·  Select “OK” to confirm adding the new user’s ACL to the specified folder. 

 

Folder Permissions 

 

 
Figure 36 – Insight Connector – Folder Permissions Dialog Window 

ACL permissions can be adjusted at any time for every user added in the folder permission’s 
dialog. Users may only grant ACL permissions if they have been given the administrator 
permission. ACL permissions may not be changed for either the owner or the administrator of 
the account. 
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The main “Folder Permissions” dialog window is now displayed again.  The username or 
email address that was just entered is now displayed in the user dialog box.  The default 
permission given to all new users is “Guest”.  This can be modified using the pull-down menu 
in the “Folder Permissions” dialog window. 

The pull-down list contains four preconfigured ACL settings: 

·  Guest 
Look up, Read, Set Seen Flag rights 

·  User 
All rights except for “Create”, “Delete”, and “Administrator” 

·  Power  User 
All rights except “Administrator” 

·  Administrator  Full  rights 
All rights 

Advanced Permissions 

More detailed permissions can be assigned by selecting the “Advanced” button. 

 
Figure 37 – Insight Connector – Folder Permissions Dialog Window 
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Figure 38 – Insight Connector – Advanced Permissions 

Each of the listed permissions can be set independently giving more granular control over folder sharing 
permissions. 

Table 1  

Permissions  Description  

Lookup The user may see that the folder exists. 

Read The user may read the folder. The user may also select the folder, fetch data, perform 
searches, and copy messages from the folder. 

Insert The user may insert new messages into the folder. 

Set Seen Flag Keep, per-user, seen state. The "Seen" and "Recent" flags are preserved for the user. 

Write The user may modify flags and keywords other than "Seen" and "Deleted" (which are 
controlled by other sets of rights). 

Post A user may send a message to the folder. This right differs from the "Insert" right in 
that the delivery system inserts trace information into submitted messages so that you 
can filter address by user name, IP address or HTTP requests.  

Create The user may create, delete or rename folders. 

Delete The user may set a message as "Deleted" or permanently delete mail. 

Administrator The user may change all the permissions on the folders. 

Folder Type 

The “Folder Type” button gives the user the ability to select a specific “type” for any IMAP 
folder except for Inbox, Outbox, Deleted Items and Sent.  
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.  
Figure 39 – Insight Connector – Folder Type    

This feature becomes useful if a user wants to create a second calendar to share with others 
rather than their standard calendar. 

3.2.2 Refresh Folders 

The “Refresh Folders” button refreshes the folder tree as seen when you press Alt + F1 
(navigation pane).  When pressed, the Insight Connector actually scans each folder, not for 
contents but for the folders themselves.  If folder changes are made on the server or if folders 
are shared to you from someone else, you would use the “Refresh Folders” to display those 
changes in Outlook.   

 
Figure 40 – Insight Connector – Refresh Folders   

 

Note:  The “Refresh Folders” button does not retrieve emails; it 
refreshes the folder tree only. 

3.2.3 Account 

Insight Connector Account Settings 
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Figure 41 – Insight Connector – Account 

 
Figure 42  – Insight Connector – Settings Dialog Window 

The Insight Connector Settings dialog window will be displayed first when selecting “Account” 
from the Insight Connector toolbar.  All of the information displayed on this screen is entered 
and configured during the Insight Connector installation process.  Changes can be made to 
this information as needed. 

3.2.4 More Settings 

To learn more about the additional settings which are available for configuration, click on the 
“More Settings…” button. 

Across the top of this new window, you will see eight tabs:  
General, Connections, Download, Folders, Send/Receive, Other Settings, Format, and 
About. 
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3.2.4.1 General 

  
Figure 43– Insight Connector – More Settings – Connections – IMAP 

The General tab has two input fields.  The first one is already filled in with a default value –      
“Insight Server Folders”.  This is the name that will appear as the display name for “Outlook 
Today”.  This is a user-defined field and can be changed. 

The second field is labeled “Other User Information”. It is optional and has no effect on the 
functionality of the software.  This is also a user-defined field. 

 

3.2.4.2 Connections 

The Connections tab is where IMAP, SMTP, Sieve, LDAP and Timeout settings are 
configured.   
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IMAP 

 
Figure 44 – Insight Connector – More Settings – Connections – IMAP 

Incoming Server (IMAP) 

·  Server name  
This is the IMAP server name that was entered during installation; it can be 
changed if needed. 

·  Port 
By default, Insight Server uses port 143.  

·  Username 
This is the user name that was entered during installation; it can be changed 
if needed. 

·  Password 
This is the password that was entered during installation; it can be changed if 
needed. 

·  Do not use secure connection 
Default configuration is to not use a secure connection. 

·  Use secured connection (SSL) 
Select this option if your server supports IMAP SSL. When selecting this 
option, the default port of 143 changes to port to 993. This value can be 
changed manually, if needed. 

·  Use Transport Layer Security (TLS) 
Make sure that your server supports TLS before selecting this option. TLS 
provides endpoint encryption. This protocol allows all communication, 
including passwords, to be encrypted. TLS is the preferred and most secured 
method of SSL. 

·  Use Persistent Connection 
The default and recommended selection is enabled. 
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Important Information : Disabling the use of persistent connections will 
negatively affect the performance of the Insight Connector. Persistent 
connections, also known as “keep alive” connections, reuse the same TCP 
connection for sending and receiving. This streamlines requests, reduces 
network traffic, network latency, CPU utilization and memory needs as it 
requires fewer resources. 

 
Test IMAP Settings 

·  Click this button to test the new IMAP settings. 
 
SMTP 
 

 
Figure 45 – Insight Connector – More Settings – Connections – IMAP 

Outgoing Server (SMTP):  

·  Server name  
This is the SMTP server name that was entered during installation; it can be 

changed if needed. 
·  Port 

By default, Insight Server uses port 25 
·  Do not use secure connection 

Default configuration is to not use a secure connection. 
·  Use secured connection (SSL) 

Select this option if your server supports IMAP SSL. When selecting this 
option, the default port of 143 changes to port to 993. This value can be 
changed manually, if needed.  

·  Use Transport Layer Security (TLS) 
Make sure your server supports TLS before selecting this option. TLS 
provides endpoint encryption. This protocol allows all communication, 
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including passwords, to be encrypted. TLS is the preferred and most secured 
method of SSL. 
 
 

SMTP Authentication: 

·  SMTP server requires Authentication   
 

Note:  SMTP Authentication is sent in plain text.  To encrypt the user 
ID and password – enable, “Use Transaction Layer Security (TLS)”. 

 
·  Use Same Authentication as Incoming Server  

This uses your email username and password that you entered when you 
setup the account. 

·  Use SMTP Authentication  
This option is used when sending email from an SMTP server that is not part 
of the normal mail server network.  i.e. an external address or a remote user.  
Enabling this feature tells the client to authenticate with the server to relay 
messages to external domains. 

Test SMTP Settings 
·  Click this button to test the new SMTP settings. 

 
Sieve  
 

 
Figure 46 – Insight Connector – More Settings – Connections – Sieve 

Sieve is a language for filtering e-mail messages. It is designed to be implemented on either 
a mail client or mail server. It is meant to be extensible, simple, and independent of an 
access protocol, mail architecture, or operating system.  

Sieve support is included for compatibility with Insight Server. Sieve can create “Out of 
Office” or “away from desk” email messages. 
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·  Server supports Sieve 
Select if email server supports Sieve filtering. 

·  Reuse incoming (IMAP) host and login configuration 
Use same information as IMAP connection information. 

·  Use Transport Layer Security (TLS) 
Make sure that your server supports TLS before selecting this option. TLS 
provides endpoint encryption. This protocol allows all communication, including 
passwords, to be encrypted. TLS is the preferred method of SSL. 

 

·  Server name  
This is the IMAP server name that was entered during installation; it can be 
changed if needed. 

·  Port 
By default, Insight Server uses port 143. 
 
 

·  Username 
This is the user name that was entered during installation; it can be changed if 
needed. 

·  Password 
This is the password that was entered during installation; it can be changed if 
needed. 

Test Sieve Settings 
·  Click this button to test the new Sieve settings. 

 
LDAP  

 
Figure 47 – Insight Connector – More Settings – Connections – LDAP 

Note:  Sieve Authentication is sent in plain text.  To encrypt the user ID and 
password, enable, “Use Transaction Layer Security (TLS)”. 
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Note: The LDAP default options are configured for optimal 
use with Insight AddressBook 3.0 and Insight Server 4.3. 

 

The Lightweight Directory Access Protocol or LDAP is an application protocol for querying 
and modifying directory services running over TCP/IP. 

An LDAP directory is a set of objects with attributes organized in a logical and hierarchical 
manner. An example of LDAP could be an address book that consists of names organized 
alphabetically.  Each name in the address book would have a corresponding email address 
and telephone number. 

LDAP shared folder name resolution enables the Insight Connector to display “actual names” 
instead of “user names” for shared IMAP folders.  

·  Use LDAP to resolve shared folder names 
Place checkmark if you have an LDAP server. 
 

Outgoing Server (SMTP):  

·  Server name  
This is the SMTP server name that was entered during installation; it can be 
changed if needed. 

·  Port 
By default, Insight Server uses port 389. 

·  Use SSL 
Select this option if your LDAP server supports IMAP Secured Socket Layer 
protocol.  
 

·  Anonymous Login 
Select this if your LDAP server allows anonymous binds (anonymous searches). 

·  User DN 
The User DN (Distinguished Name) is comprised of a unique identifier for the 
user and the domain container; the unique identifier is the container "cn=" in the 
LDAP database followed by the domain or organizational information.  

 
Note: If you are using Bynari’s Insight Server, users can find their own "User 
DN" information. 
 
Log into the web management console as a user, then click on: 

1. Preferences > “Client Configuration” 
2. "Directory Server Account", locate the field, "Account Name". 

 
An example DN might be:  “cn=testuser1,o=example.net ” 

 
If you are not running Insight Server, please consult your LDAP administrator for 
your DN. 

·  Use Incoming Server (IMAP) Password 
This uses the IMAP password from the Connections > IMAP field. 

·  Password 
This is your password to the LDAP server. 

·  Remember Password 
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Remember the password so that you do not have to enter it every time it 
accesses the LDAP server. 

Test LDAP Settings 
·  Click this button to test the new LDAP settings. 
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 LDAP Advanced options  

 
Figure 48 – Insight Connector – More Settings – Connections – LDAP – Advanced Settings 

 
Searching Options 

·  Sort returned results by: 
This option sorts the LDAP results by: 

·  First Name 
·  Last Name 
·  Display Name 
·  Email Address 

·  Display all results in a single container (deep sea rch) 
Toggling this option will allow for custom LDAP searches to group level. 

·  LDAP Filter for Users: 
This option defines the LDAP attribute for users. 

·  LDAP Filter for Groups: 
This option defines the LDAP attribute for groups. 

·  LDAP Search Attributes: 
The criteria used in the search attribute can be changed to meet your LDAP 
structural needs. This information can be found with the user’s container name or 
unique identifier in the LDAP database. An LDAP browser can quickly display 
these parameters. In this example, the data refers to the following information: 

·  cn = Container name. Typically this is the user’s full name. 
·  mail = User’s mail address. 
·  givenName = Typically, this is the first name of a user. 
·  sn = Surname or last name. 

Base DN 
·  The top level of the LDAP directory tree is the base, referred to as the "base DN". 
·  By default Insight Connector attempts to determine your LDAP base DN by your User 

DN, which you specified on the Connections > LDAP tab.  Consult with your LDAP 
administrator for your DN if the Base DN was not determined automatically. 

LDAP Server Version 
·  Select LDAP version 

Manually select version 2 or LDAP version 3. 
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·  Detect 
This button will attempt to get the LDAP server version automatically. 

LDAP attributes  

 
Figure 49 – Insight Connector – More Settings – Connections – LDAP – Advanced Settings – LDAP 
Attributes 

The value of these attributes is used to perform the searches against the LDAP 
database. These are comma delimited and can be changed depending on your setup. 

·  User Attributes 
The user attribute will search against “login” then “uid”.  

·  User ID 
The user id attribute will search against the “login” attribute. 

·  First Name 
The first name attribute will search against “givenName”. 

·  Last Name 
The last name attribute will search against “sn”. 

·  Display Name 
The display name attribute will search against “display-name”, 
“displayName”, and then “cn”. 

·  E-mail Address 
The e-mail address attribute will search against “mail”. 
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Others  

 
Figure 50  – Insight Connector – More Settings – Connections – IMAP 

 

Timeout Setting 
·  Server timeout value in number of seconds. 

The Timeout Setting tells the server how long to wait before it closes the 
session.  The default value is “0”. Acceptable values are: “0”, “30-600” 
seconds.  In a corporate environment where the user is on the same network 
as the mail server, a timeout value of “0” may be adequate. 
 
Users on a Wide Area Network (WAN) need to consider larger timeout 
settings.  Setting this value is dependent on your Internet connection speeds.  
If you are on a dial-up connection, you may want to set this value to 600 
seconds whereas if you are on a DSL connection or cable modem 
connection, 60 seconds may be acceptable. 
 
Having a value too low can cause uploading issues when sending large 
attachments where the Internet upload speeds are usually slow. 
 
 

·  Auto Registration Port 
Auto registration is disabled by default. This option allows Insight Connector 
to verify licensing with their local Insight Server. If you do not use the Insight 
Server, DO NOT enable the Auto Registration Port Checkbox. By default, 
port 80 is used. This option can be changed depending on your Insight 
Server and firewall configuration. 
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Important Information : The Insight Connector was designed to 
function over LAN-based and high speed broadband connections.  
Many remote users are able to utilize the Insight Connector as it was 
designed.  For users on poor remote connections, utilizing the Insight 
Access web client may be a better option. 
 

·  Use SSL 
Use secure socket layer protocol to register. 

3.2.4.3 Download 

 
Figure 51 – Insight Connector – More Settings – Download 

 
Download Options 

·  Download Headers Only 
Enabled by default, this option improves the performance of the initial 
synchronization of the emails downloaded for Outlook.   It downloads the 
header only for email messages. When the message is selected for viewing, 
the entire message is downloaded.  
 

Note:  Tasks, journals, contacts and calendar events 
are always set for full-content download when 
selected for viewing. 

 
·  Download Contents of Message Only 

Disabled by default, this option downloads the entire message during the 
synchronization of emails. Attachments are downloaded when the message 
is selected for viewing.  
 
 

·  Download Contents of Message and Attachments 
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Disabled by default, this option downloads the entire message and 
associated attachments during the synchronization of emails. 
 
Download All Attachments 
 This option will download all attachments. 
 
Download Attachment Limit 
 This option will set the download attachment limit size in bytes. Any 
value is accepted in this field. The default is 50,000 bytes. 

 
Download Message progress 

·  Show progress indicator when loading messages 
When this box is checked, a progress indicator will appear when 
synchronizing any folder with more than 50 messages.  This option is 
checked by default. 

·  Indicator threshold (number of messages) 
This option allows you to modify when the indicator will appear.  By default, 
this value is set to 50 messages, adjusting this to zero will display the 
indicator for every message. 

3.2.4.4 Folders 

 
Figure 52  – Insight Connector – More Settings – Folders 

 
Folder Type 

·  Use ACL to set folder types 
Enabled by default, it allows the Insight Connector to use custom IMAP folder 
ACLs to specify the specialized folder types used by Outlook.  These are 
“Calendar”, “Contact”, “Task”, “Journal”, “Notes“, and “Mail”.  This option 
increases performance since the Insight Connector no longer has to locate a  
hidden synchronization message to determine a given folder’s type. 
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Folder List 

·  Show All Folders 
This is enabled by default and tells the Insight Connector to automatically 
subscribe to all folders found under the user’s folder list. 
 
 
 

·  Show Only Subscribed Folders 
In large environments, the default value of “Show All Folders” may not be 
desirable.  This option allows the users to individually select only the folders 
they want to see in Outlook. 

Important Information:  When manually selecting folders, make sure that 
default folders are checked. i.e. Calendar, Contacts, Deleted Items, Sent Items, 
Outbox and Tasks.  If you uncheck them, it will cause Outlook to recreate them 
on the IMAP server.  This is a default behavior of Outlook. 

3.2.4.5 Send/Receive 

 
Figure 53 – Insight Connector – More Settings – Send/Receive   

Insight Connector utilizes IMAP IDLE to update the Inbox folder.  For servers that do not support 
IMAP IDLE 
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3.2.4.6 Other Settings  

 
Figure 54 – Insight Connector – More Settings – Miscellaneous 

The Other Settings tab contains two sections; one for read receipt request options and the 
second for local cache options. 

Message Receipt Options 
 How would you like to respond to requests for read receipts on incoming messages? 

·  Prompt me before sending a response 
This option is the default setting.  This setting “prompts” the user to choose 
between sending a read receipt or not. 

·  Always send a response [default selection] 
This option automatically sends a response to the sender of a read receipt 
request. 

·  Never send a response 
This option never sends a response to a read request sender. 

 
Local Cache Options 
 Store local message cache in the following directory: 

·  Default Location 
The default location for the local cache is: 
 
C:\Documents and Settings\[user name]\Local Settings\application 
data\Bynari\Bynari Insight Connector 4.0\Accounts\[Outlook profile 
name]\[email address]\ 
 
The name of the local cache file is: LocalCache.pst 

·  Custom Location 
This option allows you to change the location of the local cache.  This 
enables the administrator to place the local cache on the network through a 
network share for user data backup if needed. 
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Note:  Read, Write, Delete and Change permissions within Microsoft 
Windows are required for any Custom Location. 

 
Note:  Any changes made to the location of the local cache will require a 
restart of Outlook.  If you do not restart Outlook, you may see errors, 
because the Insight Connector must create the LocalCache.pst file.  

 

3.2.4.7 Format 

 
Figure 55 – Insight Connector – More Settings – Format 

 
 
Message Receipt Options 
 

Note: “Use Kolab Format” option is available in the Kolab version 
of Insight Connector 4.0.  

·  Use Microsoft Message Format 
This option is the default setting.  This is also known as “.tnef" formatting 
which stands for Transport Neutral Encapsulation Format. This allows files to 
contain rich text formatting used by e-mail messages, such as bold, italics, 
underlining, etc… 

·  Use iCal Format 
This option is turned on by default in the “ical” or “iCalender” format version 
of Insight Connector. iCalendar is a file format which allows sending meeting 
requests and tasks to other internet users via email or sharing files with an 
.ics extension. 
 
“iCal” format is significantly smaller than the “.tnef” format which can improve 
performance and save disk space. 
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Note: If you use a Kolab server or an iCalendar compatible 
server, you may not need to select “Use Microsoft Message 
Format”. If you are unsure, it is best to select both options. 

 
·  Use Kolab Format 

Use this option only if you are running a Kolab IMAP server. Kolab uses a 
unique XML format attached to email specifically for Kolab groupware 
servers. The XML holds information for contacts and calendar events. 
 

3.2.4.8 About 

 
Figure 56 – Insight Connector – More Settings – About 

About tab 
The about tab provides information about the Insight Connector.  It contains the version 
number as well as all licensing information.  

3.2.5 Quota 
Used to display the user’s current quota status. 

 
Figure 57 – Insight Connector – Toolbar Quota button 
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Figure 58 – Insight Connector – Quota 

3.2.6 About 

 
Figure 59  – Insight Connector – About 

The “About” button on the Insight Connector toolbar performs the same function as the “About” tab 
discussed above in section 2.5.4.9. 

4 Using Insight Connector 
Insight Connector 4.0 provides Outlook with a MAPI transport service that makes connecting to 
an IMAP server transparent to the end user.  The following sections describe some of the 
additional dialogs introduced by the Connector such as Folder permissions as well as 
documenting configuration changes needed for features such as Free/Busy.  

4.1 Viewing Shared Folders 

Note: Private events (calendar, contacts, and tasks) are stored on the server. Only 
the folder owner will see private events.  
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Other users' shared folders will appear under ‘Other Users’ in the folder list. 

 
Figure 60 – “Other Users” shared folder list 

Public folders created on Insight Server will display under ‘Shared Folders’ in Outlook.  

  
Figure 61 – “Shared Folders” public folder list 

 
 

Note:   Upgrade your Insight Server to at least 4.2.2 to support private events. 

 

4.2 Free/Busy Configuration 

Outlook allows users to share free/busy information from their calendars with other users on their 
mail server. With the Microsoft Office Internet Free/Busy Service, users can publish their 
free/busy times to a shared Internet location. Members using this service can view each other's 
free/busy information when viewing shared calendars or creating meeting requests. 

 
Configure Free/Busy 

·  Open Options in Outlook 
On the Outlook Toolbar, select Tools > Options. 
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Figure 62 – Outlook Tools, Options 

 
·  This opens a new window; select the Preferences option tab. 

 
 
 
Options - Preferences 
  

·  Click on “Calendar Options…” 
 

 
        Figure 63 – Tools – Options 
 
 
Calendar Options - Advanced options 
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       Figure 64 – Tools – Options – Calendar Options 
 

Note: “When sending meeting requests over the Internet, 
use iCalendar format” option will likely be grayed out. This is 
normal. 

 
·  Enable alternate calendar 

Select this option if you wish to enable an alternate calendar. 
·  Click on “Free/Busy Options…” 

Select to change the Free/Busy Options. 
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Free/Busy Options 
 

 
Figure 65 – Tools – Options – Calendar Options – Free/Busy Options 

 
Options 
  

·  Publish “2” month(s) of Calendar free/busy informat ion the server 
Enter the number of months of Free/Busy information to be published. 
The default interval is 2 months. This value represents the number of months 
from today's date.  
 

·  Update free/busy information on the sever every “15 ” minutes 
The default time is every 15 minutes. This value represents how often 
Outlook will update the user's Free/Busy information on the server.  
 

Internet Free/Busy 
·  Publish at my location 

This option must be checked. In figure 69, a path name is shown. Insert your 
information in place of the variables, “%NAME%.vcf”. 

 
Note: If you are using Insight Server 4.3, use the below 
example by changing the server name and replacing 
%NAME% with your username.  
ftp://mail.example.net/freebusy/%NAME%.vcf 

 
·  Search location 

Enter the URL for the shared free/busy search location. 
 

Note: If you are using Insight Server 4.3, use the below 
example by changing the server name and replacing 
%NAME% with your username. 
http://mail.example.net/freebusy/%NAME%.vcf  

 
·  Click “OK” to apply the Free/Busy settings. 
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4.3 Show / Hide Toolbar  
·  Toggle toolbar display 

On the Outlook Toolbar, select View > Toolbars > Insight Connector 4.0. 

It places a check mark next to the name to show that the Connector is enabled. 

  
Figure 66 – Show/Hide Insight Connector Toolbar 

If you have hidden the Insight Connector toolbar at the time of the installation, you can 
show the toolbar by following the above steps. 

4.4 Purge Messages 

Messages deleted in Outlook are marked for deletion but are not deleted on the IMAP 
server. Instead, the message are labeled then moved to the “Deleted Items” folder. This 
allows for users to access deleted messages until they are no longer needed. To 
permanently delete messages on the server, use the "Purge Messages" command. 

 
·  Click on “Tools” > “ Purge Messages” 
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Figure 67 – Purge Messages 

5 Registering and Unregistering Insight 
Connector  

Insight Connector 4.0 is configured to use auto registration by default when “Insight 
Server” is selected during installation. Auto registration is designed for users of both the 
Insight Connector and Insight Server. With auto registration enabled, the Insight 
Connector will verify that an active license exists for the client when Outlook starts.  It is 
recommended that users of the Insight Server utilize this feature of the Insight Connector.   

If you do not have an Insight Server or do not wish to use auto registration, you can 
register your copy of the Insight Connector using the “ About”  tab of the Insight 
Connector toolbar. 

5.1 Auto Registration 

Enable or disable auto registration 

·  Click on the “Account” tab in Insight Connector toolbar. 

 
Figure 68 – Insight Connector – Account 
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·  Select “Connections” > “Others” . 

 
Figure 69 – Insight Connector – More Settings – Connections – IMAP 

 

Important Information:  Do not enable auto registration if you 
do not use the Insight Server.  

 
·  Auto Registration Port 

Auto registration is either enabled or disabled depending on your Insight 
Server selection during installation. This option allows Insight Connector to 
verify licensing with a local Insight Server. By default, port 80 is used. This 
option can be changed depending on your Insight Server and firewall 
configuration. 

 
·  Use SSL 

Use secure socket layer protocol to register. 

5.2 Register the Insight Connector 
·  Click on “About” in the Insight Connector Toolbar. 
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Figure 70  – Insight Connector – About 

 
Figure 71 – About 

·  Click on “License” . 

 
Figure 72 – Key Support button 

 
·  Enter your product license key 

Copy/Paste your license key in the space provided. 
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·  Manual Registration 
See section “manual registration” below. 

·  Enter the license certificate below: 
This is only used during manual registration. 

·  Which port would you like to use for the registrati on? 
Bynari license key server listens on ports 80 and 3080. If port 80 is blocked,  
port 3080 can be used as an alternate port. 
 

Note:  The license key server URL is http://register.bynari.net. 

 
Note:   If you encounter any issues while activating your Insight 
Connector license, ping the license key server to verify proper 
internet connectivity.  

·  Click “OK” to register Insight Connector. 
 

Manual Registration 
·  Enter your product license key 

Copy/Paste your license key in the space provided.  
·  Manual Registration 

Contact Bynari Support at support@bynari.net and request a manual license 
certificate. 

·  Enter the license certificate below: 
Paste entire certificate in the space provided. (See manual certificate 
example.) 

 
Figure 73 – Manual certificate example 
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Figure 74 – Manually entering the information 

�  Click “OK” to complete manual registration. 
 

5.3 Registration Complete 
·  After registering over the internet or manually, yo u should see the following screen. 

 
Figure 75 – Manually entering the information 

 
Bynari Insight Connector License Information   
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·  License Key 
This is the license key used to register Insight Connector. 

·  License Expire 
This will display when and if your license expires. 

·  Support Expires 
This option will show the date Bynari support expires. 

·  Number of Licenses Used 
This displays the number of licenses used vs. the number of licenses that 
you have purchased. 

·  Total License Available 
This displays the number of licenses available or purchased. 

·  Supported Versions 
The Connector version supported for this license key. 

·  Supported Options 
Formats that are supported such as iCal or Kolab are listed. 

  
Click “Refresh” to update dialog screen for license information. 

 

5.4 Unregister Insight Connector 
·  Click on “About” on the Insight Connector Toolbar. 
·  Click on “License” .  

 

   
           Figure 76 – Connector License information 
 

·  Click on “Unregister” . 
This will unregister Insight Connector from your computer. 
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6 Reporting Problems 
When reporting problems, be sure to include the following information: 

·  Microsoft Windows version number and patch level. 

o Right click on “My Computer” icon on the Desktop and select Properties. The Windows 
version and patch level will be listed under System: in the General tab dialog. 

·  Microsoft Outlook version and patch level. 

o Right click on Help in Outlook and select About Microsoft Outlook. The Outlook version 
and patch level will be listed. 

·  The full version number of the Insight Connector. 

o Click “About” on the Connector toolbar. The connector version and build number (4.0-
xxxx) will be listed. 

 

To contact technical support:  

U.S. Toll Free Telephone:  1-800-241-1086 
International Telephone:  001-214-350-5772 
 
To open a new support ticket:  http://www.bynari.net/support/  

For FAQs:  http://www.bynari.net/users/kb.php 


